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CHAPTER 1.  CREATE A TEMPLATE FOR A SCOPE OF WORK

1. Create a New Scope of Work Document

1.1. Start New Document

Select the “Create Scope of Work Document” button to start creating a new document.

1.2. Add Details

Input the Project Manager, Project Name, and Contract No (if available).

Note: The Project Manager and Project Name fields are required.

1.3. Project Overview

The Project Overview grid shows the items that will be listed in the introductory section of the
document. No action is required in this section of the Scope Template App. The content for these
items can be changed after the document has been created.
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1.4. Add Project Overview Sub Items

For some projects, there may be cases where additional information is needed in the Project
Overview section. Select the checkboxes for all the options that apply to the project.

1.5. Select Work Packages to Include in the Scope of Work

In the next section, Scope of Work, select the checkboxes for all Work Packages that apply to the
project.

1.6. Click Create Document Button

Once all the options have been selected, select the “Create Document” button to generate the
document.
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1.7. Open Document

After the document has been created, open the document.

1.8. Enable Editing

Before making changes, there may be a prompt preventing changes. Please select “Enable Editing”
to edit the document.

1.9. Update Table of Contents

A prompt should appear as a request to update the fields in a document. Please select “Yes” as this
will dynamically create the initial Table of Contents for the document.

If you do not see this prompt, the Microsoft Word setting to “Update automatic links at open” is
not properly configured. Please contact MNIT to disable the DontUpdateLinks field by installing a
registry key.

1.10. Finish Document

SAVE YOUR FILE. The application does not save the template output file for you. At this point you
must save the Microsoft Word document to the MNDOT server with a unique file name. This is your
file. If you do not save it you will need to start over to create a new output file.

Now you have a draft scope of services ready to be edited to reflect the specifics of your project.
Please read the scope carefully and add or delete sections as necessary. Red text is highlighted
where project specific information is required. Follow instructions within the file (noted in red) to
complete the document and fill in any blanks. Make additional changes as needed.

See Chapter 2 for helpful tips to simplify inserting text from other documents, managing document
styles, updating table of contents and other WORD software tricks.
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CHAPTER 2.  TIPS FOR EDITING THE TEMPLATE

1. Content

1.1. MnDOT Specifications Writer's Style Guide

Please see the MnDOT Specifications Writers’ Style Guide (December 2012) for guidance on the
writing style that should be used when writing a scope of services. This guide can be found at
http://www.dot.state.mn.us/pre-letting/prov/pdf/style-guide.pdf

1.2. Active Voice

Used well, the active voice adds clarity by assigning responsibility, and lessens a reader’s burden by
simplifying sentence structure and eliminating words. The templates in this application have
incorporated this goal. Additions to or revisions of the template narrative should be written in a
consistent active voice.

1.3. Plain Language

Additions to the template scopes should be written in plain language. Any abbreviation needs to be
spelled out the first time it is used. Avoid using jargon. Use the simplest language that says clearly
and accurately what needs to be said.

1.4. Deliverables

At minimum, each work package should have an identified deliverable, which should be noted at
the end of each task. Deliverables should be tangible products. A tangible product is like a layout,
road plan, report, or meetings with agendas and minutes. An intangible product is something like
obtain public consent. The deliverable statement should contain the following elements:

a. Items to be delivered
b. Quantity of each item to be delivered
c. Electronic or hard copy deliverable, unless that is previously covered in Project Overview

section.
A summary of deliverables would be redundant and is not recommended in the scope of services.

Examples:

Deliverable: Electronic copy of issues list, action items and dates of resolution.

Deliverable: Facilitate (insert #) meetings to be held at insert location. Provide agenda, content and
meeting summary.

Deliverable: One electronic copy of the 30% Design Package

1.5. Redundancy

Repetition is both unnecessary and counterproductive when writing a scope of services. Pervasive
repetition can create opportunities for misunderstanding and inconsistencies or errors. The
templates have been organized to state things only once. Don’t add items to sub-scope sections
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that are covered elsewhere. For example, Standards are listed in the General Overview section, and
therefore do not need to be repeated in subsequent scope areas (e.g.; road plans or wetlands). If
unique standards are required you should add them to the Standards section of the Project
Overview scope, or the specific scope area, but not both.

2. Formatting

2.1. Text Styles

The scope of work exhibit for Professional/Technical contracts will be developed utilizing an outline
format. In order to create an outline, styles must be used.

2.1.1. Accessing Text Styles

The scope of work template document is embedded with styles for formatting. You can access the
styles from the Quick Style Gallery under the Home tab above, which looks like this:

To expand the list of Text Styles, click the arrow icon in the bottom right corner of the Styles menu,
which looks like this:

2.1.2. Word’s Navigation Pane

When styles are used, the scope document created will be able to generate a Table of Contents and
an outline that can be viewed in the Navigation Pane on the left of the screen.  The Navigation Pane
can be accessed by hitting Ctrl+F and selecting “Headings”, or by navigating to the View tab and
checking the Navigation Pane box. This can help you easily navigate scope documents in Microsoft
Word.
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2.1.3. Description of Heading Styles

The scope of work exhibit template uses two sets of styles, one for the introduction and one for the
scope of services section. These are differentiated to allow the Scope of Services section to start
with number 1, yet provide a numbering system to the Project Overview section for ease of
referencing.

For the Introduction, use the styles “Section Heading,” “Intro Heading 1,” “Intro Heading 2,” “Intro
Heading 3,” “Intro Heading 4,” and “Normal.”  These Intro Headings are for elements within the
project overview.

Work tasks in the Scope of Services section will be numbered using a separate set of heading styles.
Work tasks use the styles “Section Heading,” “Heading 1,” “Heading 2,” Heading 3,” “Heading 4,”
“Heading 5,” “Heading 6,” “Heading 7,” and “Normal.”

Headings 1, 2, 3, and 4 are numbered and will be used for the title of each deliverable or activity.
The headings should be applied in order to create an outline based on the content—Heading 1,
then 2, then 3, then 4.

Headings 5, 6 and 7 are not numbered and may be used in the description of a work package or
activity to help define different subsections. Like the first four headings, these should be applied in
numerical order.

STYLE DESCRIPTION
Normal Body paragraphs should be styled with Normal.

There is spacing built into the style so you do
not need to add returns between paragraphs.
The Normal style is Calibri Regular and the size
is 11 point. The Normal style is set with a .3-
inch indent.



Scope Template App
User Guide and Administrative Manual

10

STYLE DESCRIPTION

Section Heading Section Heading is Calibri Bold and the size is
11 point.
Section Heading is not numbered. The purpose
of this is to have numbering begin with the
scope of work items for the consultant
contract.
Section Heading has a 1/2pt solid black rule
above it.

1. A.1. Intro Heading 1 Intro Heading 1 is Calibri Bold and the size is 11
point. Intro Heading 1 is not indented. Intro
Heading 1 is numbered first with a Capital A,
followed by a period and a number.

A.1.1. Intro Heading 2 Intro Heading 2 is Calibri Bold and the size is 11
point. Intro Heading 2 and all subsequent Intro
Headings are indented .3 inches. Intro Heading
2 has one more level of numbering.

A.1.1.1. Intro Heading 3 Intro Heading 3 is Calibri Bold and the size is 11
point. Intro Heading 3 has one more level of
numbering.

A.1.1.1.1. Intro Heading 4 Intro Heading 4 is Calibri Bold Italic and the size
is 11 point. Intro Heading 4 has one more level
of numbering.

1. Heading 1 Heading 1 is Calibri Bold and the size is 11
point. Heading 1 is numbered with a single
digit. In this way, items within the scope will be
numbered sequentially starting with the
number 1.

1.1. Heading 2 Heading 2 is identical to Heading 1 as
described above, but with increased depth for
numbering and .3-inch indent.

1.1.1. Heading 3 Heading 3 is identical to Heading 2 as
described above, but with increased depth for
numbering.

1.1.1.1. Heading 4 Heading 4 is Calibri Bold Italic and the size is 11
point. Heading 4 has increased depth for
numbering.

Heading 5 Heading 5 is Calibri Bold Italic and the size is 11
point. Heading 5 and any subsequent headings
do not get a number.

Heading 6 Heading 6 is Calibri Italic and the size is 11
point.

Heading 7 Heading 7 is Calibri Regular Underlined and the
size is 11 point.
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2.1.4. Description of List Styles

Lists of items that are not numbered sections should be lettered, rather than bulleted for ease of
reference. Examples of lists may include a listing of intersection locations, a list of references for a
project, or other lists that do not fit within other formatted headings of the scope outline.

In the Introduction, lists are styled with the Intro List Alpha style. The lettering restarts at “a” after a
new Intro Heading.

a. Intro List Alpha
b. Intro List Alpha
c. Intro List Alpha

In the Scope of Services section, lists are styled with the List Alpha style. The lettering restarts at “a”
after a new Heading.

a. List Alpha
b. List Alpha
c. List Alpha

2.1.5. Using Styles for Emphasis within Narrative

Additional styles are set up for use within the narrative if needed for emphasis. Examples are noted
below. These styles are also available in the Styles Tab.

If you would like text to be bold, rather than selecting B from the Font tab, select Strong from the
Styles tab.

If you would like text to be italic, rather than selecting I from the Font tab, select Emphasis from the
Style tab.

If you would like text to be bold italic, select Intense Emphasis from the Style Tab rather than using
the Font Tab to format.

2.2. Page Formatting

2.2.1. Page Margins, Header, and Footer

Page margins in the scope of work template are set to 1 inch on the top, right, and left, and 1.2
inches on the bottom. Headers and footers are set to be .5 inches from the top and bottom of the
page respectively.
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3. Updating the Table of Contents

After you have finished editing your scope of work document, it is necessary to update the Table of
Contents.

The Consultant Scope of Work web application will autogenerate a Table of Contents based on your
selections in the Scope Template App. This will appear on the first page of the exported document.

To update the Table of Contents, simply place your cursor within the existing Table of Contents and
click Update Table.

The following dialogue box may appear. If so, check “Update entire table” and click OK.
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4. Incorporating Content from Other Sources

You may wish to reuse content from previous scope of work exhibits. Any content you bring in from
another source should adopt the editorial style and formatting outlined in this guide by using the
following steps.

4.1. Copy and Paste Text from Another Document

To Copy and Paste text from another source follow the following instructions.

1. Select text in your source document that you intend to copy to the new scope of work
document.

2. Use the Shading tool (picture of bucket) under the Home tab to make it another color (red, for
example).

3. Copy the now shaded text using Ctrl-C and paste that text into your new document using Ctrl-V.
4. Place your cursor in a paragraph that you'd like to apply new style.
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5. Click on "Select All Text With Similar Formatting". This option is in the Home tab under the
Select drop down menu. Using the "Select All Text With Similar Formatting" option allows you to
style multiple items at the same time.

6. Click on the proper style from the style gallery to apply to the selected text.  Do this for each
section of text that you'd like to change until no shaded text remains.

7. If any text remains shaded, place your cursor in the text, click on "Select All Text With Similar
Formatting", and change the Shading to none (or choose the appropriate style from the Style
Gallery – such as “Normal”).

If the Copy and Paste method described above does not work as described, do the following.

1. Select text in your source document that you intend to copy to the new scope of work
document.

2. Copy the selected text using Ctrl-C.
3. Paste the text into your new document using the Paste-Keep Text Only option. Right click in your

new document where you want the text to be inserted, and select the Paste icon with the large
capital letter A.

4. The text will be pasted without any formatting or styles applied. Follow the guidelines outlined
in Section 3.1 of this document to style the new text to match the scope of work template
formatting.
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CHAPTER 3.  ADMINISTRATION MANUAL

This chapter is for maintenance and management of this application. If you have suggested changes
to any of the existing template work packages, please contact Central Office Project Management
Unit. Central Office Project Management is responsible for maintaining the application and
updating the templates.

1. Access the Admin Section

The Admin Section is where the templated content can be changed. Access is limited to this area,
so not all users will be able to make changes. To request permissions, please contact Central Office
Project Management Unit to be granted access.

1.1. Click Admin Button

From the app home page, select the “Admin Section” button in the upper right corner.

1.1.1. Button Availability Dependent on Security

If the button is not available, please contact Central Office Project Management Unit to be granted
access to the Admin Section.

Instructions on how to grant users access to the Admin Section can be found under item 6 of the
Administration Manual.

1.2. Select the Type of Change You Want to Make

There are four different template changes that can be made.

a. Add or Edit Project Overview: Select the “Add or Edit Project Overview” button to make
changes to the items in the Project Overview section of the document.

b. Order Project Overview: Select the “Change Project Overview Default Order” button to
adjust the default order of the Project Overview section items.

c. Add or Edit Work Package: Select the “Add or Edit Work Package” button to make
changes to the Scope of Work items.

d. Order Work Packages: Select the “Change Work Package Default Order” button to adjust
the default order of the Scope of Work section items.
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2. Add or Edit Project Overview

From the Admin Section, select the “Add or Edit Project Overview’ button to open the view to make
changes to the Project Overview items.

2.1. Add a New Project Overview Item

To create a new Project Overview item, select the “Start New Project Overview” button.

2.1.1. Add Title

For the new Project Overview item, add a Title. This will appear in the document with the “Intro
Heading 1” style.

2.1.2. Add Description

Next, add a description to the Project Overview item. This will appear below the Title in the
document with the “Normal” style.

Note: When pasting content from Microsoft Word into the text editor, hidden Microsoft Word tags
may change the format or appearance. Verify the format and appearance is correct before moving
to the next step.

2.1.3. Adjust Status

If the Project Overview item is not ready to be added to new documents, the Status can be changed
to “Inactive” until the content is completed. Use the dropdown to adjust the Status of the Project
Overview item.
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2.1.4. Save

When the initial content has been added to the Project Overview, select the “Save Project
Overview” button to create the item in the database.

2.2. Add Project Overview Sub Item

Additional sub items can be linked to a Project Overview item after it has been created in the
database. Depending on the project, end users will have the option to select the Project Overview
sub items for their document. If selected, they will appear directly below the associated Project
Overview.

2.2.1. Add New Sub Item

To create a new sub item, select the “Add New Sub Item” link.

2.2.1.1. Add Title

When the window appears, add a title to the sub item. The title will appear in the document with
the “Intro Heading 2” style.
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2.2.1.2. Add Description

Next, add a description to the sub item. This will appear below the Title in the document with the
“Normal” style.

Note: When pasting content from Microsoft Word into the text editor, hidden Microsoft Word tags
may change the format or appearance. Verify the format and appearance is correct before moving
to the next step.

2.2.1.3. Adjust Status

If the sub item is not ready to be added to new documents, the Status can be changed to “Inactive”
until the content is completed. Use the dropdown to adjust the Status of the sub item.

2.2.1.4. Save Sub Item

To save the new sub item, select the “Update” link.

2.2.2. Modify Sub Item

To modify an existing sub item, select the button with pencil icon. Then, repeat steps 2.2.1.1.
through 2.2.1.4.
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2.2.3. Delete Sub Item

To delete a sub item, select the button with the X icon and confirm the item should be deleted.

Note, this will completely remove the sub item from the database and it will not be recoverable!

2.3. Edit Project Overview Item

To edit an existing Project Overview item, select a Project Overview an item from the dropdown.

2.3.1. Make Content Changes

Follow steps from 2.1.1 through 2.2.3 to make any necessary changes to the Project Overview item.

2.3.2. Save

After the changes have been made, remember to select the “Save Project Overview” button to save
all the modifications.

2.4. Delete Project Overview Item

To completely remove an existing Project Overview item, select the “Delete Project Overview”
button.

Note, this will completely remove the sub item from the database and it will not be recoverable. It is
recommended to change the Status of the Project Overview item to “Inactive” if the item could be
used again.
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3. Order Project Overview

The order of the Project Overview may need to change as new items are added, updated, or
removed. To adjust the default order, return to the Admin Section and select “Change Project
Overview Default Order” button.

3.1. Drag & Drop Position

The grid will show the existing order for all active items in the Project Overview section. To adjust
the order, left click and hold a row for the item that needs to be moved. Then, drag the row up or
down into the correct position and release the left click button.

3.2.  Change Order with Buttons

The last column in the grid has buttons to reorder the Work Package items. The button with the up
arrow will move the row above the next closest row above. The button with the down arrow will
move the row below the next closest row below.
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4. Work Package Introduction

This application can both add deliverables for P6 schedule work packages and work packages that
are not in P6. If a work package is defined in the P6 Work Package Dictionary, then copy its titles
and activity names word for word and use those activity codes. The intent is that the consultant
templates match the organization and nomenclature of the P6 Work Package Dictionary.

Custom work packages can be added to this application that are not in P6. However, the
Department should avoid adding a lot of custom work packages that are only unique to one District
or are seldom used. Each Project Manager can always add any text and custom work packages to
the MSWord document after they create the original template for a specific project.

The Central Office Project Management Office should consult the Project Management Leadership
Group to determine what non-P6 custom work packages should be added to this application.

4.1. Add or Edit Work Packages

From the Admin Section, select the “Add or Edit Work Package” button to open the view to make
changes to the Work Packages.

4.2. Add Work Package

To create a new Work Package, select the “Start New Work Package” button.

4.2.1. Add Work Package Name

For the new work package, add a name. If the work package is in the P6 Work Package Dictionary,
then use the same name in that dictionary. This will appear in the document with the “Heading 1”
style.

4.2.2. Add Source Type Code

Next, add the Source Type Code. The Source Type Code is required by the Contract Administration
Office. Contact the Contract Administration Office if you are unsure which Source Type Code to use.

4.2.3. Adjust Status

If the Work Package is not ready to be added to new documents, the Status can be changed to
“Inactive” until the content is completed. Use the dropdown to adjust the Status of the Work
Package.
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4.2.4. Add Description

Next, add a description to the Work Package. This will appear below the Work Package Name in the
document with the “Normal” style.

Note: When pasting content from Microsoft Word into the text editor, hidden Microsoft Word tags
may change the format or appearance. Verify the format and appearance is correct before moving
to the next step.

4.2.5. Save Work Package

When the initial content has been added to the Work Package, select the “Save Work Package”
button to create the item in the database.

4.3. Add Activity Item

Activities can be assigned to Work Packages. These items will appear after the description of the
Work Package.

4.3.1. Add New Activity

To create a new Work Package activity, select the “Add New Activity” link.

4.3.1.1. Add Activity Name

After the window opens, add a title to the activity. If the activity is in the P6 Work Package
Dictionary, then use the same name in that dictionary.

4.3.1.2. Add Heading Style

Select a Heading Style to apply to the Work Package item. See how to use headings in Section 2.1.3
of this Manual. Headings 3 and 4 are nested headings. Remember to go to the Order Work
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Packages section to get the nested headings in the right order. For example, the user may create 3
activities under Heading 2 first. Then later realize they want to add a subitem to the first activity.
This is done by adding the activity and giving it the Heading 3 style. However, this application places
that newly added activity at the end of the list. The user then needs to go to the Order Work
Packages section and move that new activity up in the list so it is under the correct Heading 2
activity.

4.3.1.3. Add Activity Code

If this is a P6 Schedule Activity, then add the P6 Activity Code here. If it is not P6 Schedule Activity,
then leave the field blank.

4.3.1.4. Add Description

Insert the content describing the Work Package item or activity.

Note: When pasting content from Microsoft Word into the text editor, hidden Microsoft Word tags
may change the format or appearance. Verify the format and appearance is correct before moving
to the next step.
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4.3.1.5. Save Work Package Item

Finally, save the Work Package item by selecting the “Update” link.

4.3.2. Update Work Package Item

To modify an existing Work Package Activity or item, select the button with pencil icon. Then,
repeat steps 4.2.1.1. through 4.2.1.5.

4.3.3. Delete Work Package Item

To delete a Work Package Activity or item, select the button with the X icon and confirm the item
should be deleted.

Note, this will completely remove the work package item from the database and it will not be
recoverable!

4.3.4. Order Work Package Items

After multiple Work Package items have been created, the default order can be adjusted. The order
will determine how the headings will be numbered when the document is created.
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4.3.4.1. Drag & Drop Position

The grid will show the existing order for all Work Package items and activities. To adjust the order,
left click and hold a row for the item that needs to be moved. Then, drag the row up or down into
the correct position and release the left click button.

4.3.4.2. Change Order with Buttons

The last column in the grid has buttons to reorder the Work Package items. The button with the up
arrow will move the row above the next closest row above. The button with the down arrow will
move the row below the next closest row below.

4.4. Update Work Package

To edit an existing Work Package, select a Work Package from the Edit Work Package
autocomplete.

4.4.1. Make Content Changes

Follow steps from 4.1.1 through 4.3.1 to make any necessary changes to the Work Package.

4.4.2. Save

After the changes have been made, remember to select the “Save Work Package” button to save all
the modifications.

4.5. Delete Work Package

To completely remove an existing Work Package, select the “Delete Work Package” button.

Note, this will completely remove the Work Package and its corresponding Work Package Items
from the database and it will not be recoverable. It is recommended to change the Status of the
Work Package to “Inactive” if the item could be used again.
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5. Order Work Packages

The order of Work Packages may need to change as new items are added, updated, or removed. To
adjust the default order, return to the Admin Section and select “Change Work Package Default
Order” button.

5.1. Drag & Drop Position

The grid will show the existing order for all active Work Packages. To adjust the order, left click and
hold a row for the item that needs to be moved. Then, drag the row up or down into the correct
position and release the left click button.

5.2. Change Order with Buttons

The last column in the grid has buttons to reorder the Work Packages. The button with the up
arrow will move the row above the next closest row above. The button with the down arrow will
move the row below the next closest row below.

6. Granting Access to Admin Section

The next steps will show how to grant new users access to make changes to the template content
within the app.

6.1. Open FIM

Using Internet Explorer, load into FIM (Microsoft Identify Manager):

https://fimportal.dot.state.mn.us/IdentityManagement/default.aspx

6.2. Locate Security Group

Go into Manage My SG’s and click into the MnDOT App Statement of Work Admins group.
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6.3. Add New Members

Select the Members tab. Then, add users by clicking the icon as seen highlighted in yellow in the
following image:

6.4. Search Names & Select Accounts

Search for the name(s) needed to be added as App Administrators. Select the checkboxes next to
the name of each person who will be added.

6.5. Confirm Selection

Select “OK” and “OK” again to confirm the new members. The selected people should now have
access to the Admin Section.


